Don't know where to start?
Read these tutorials:

**Converting videos**
- Change the video format

**Converting for devices**
- Watch videos on your phone or tablet

**Converting audio**
- Play any audio anywhere

More questions?
Write us an e-mail at support@movavi.com
Learn about adding media.

Find the files you want to convert in File Explorer and drag them onto the Movavi Video Converter Premium window. The files will now be added to the conversion queue.

Learn about adding media.
Choose output format
1. Click the Video tab to show a list of video formats and presets.
2. The video formats are sorted into groups. Click the group with the output format you want to use.
3. A list of presets will appear. Here, you can choose a different resolution for the files, or choose the preset without a specified resolution to convert with the original resolution (for example, "MKV").
The currently selected output format will be shown at the bottom of the window.

Edit files (optional)
If a file needs some quick editing, click the Edit button next to it. The Editor window will open, where you can quickly trim, crop, and adjust the file.
Learn more about editing

Choose output folder
At the bottom of the window, check the Save to box to see where the new converted files will be saved. To save them to a different folder,
click the folder icon and choose the new location in the File Explorer box.
Learn more
Uploading files

Convert
Finally, click **CONVERT** in the bottom right-hand corner to start processing the files.

### Remove trial restrictions

When you first open your copy of **Movavi Video Converter Premium**, it will be running in **LIMITED TRIAL MODE**. In trial mode, you can try out all of the main features, but the following trial restrictions will apply:

### What's the difference between trial mode and the full version?

In trial mode, you can try all of the features of the full version, however, several restrictions apply:

<table>
<thead>
<tr>
<th><strong>TRIAL VERSION</strong></th>
<th><strong>FULL VERSION</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Movavi Video Converter Premium stops working after 7 days</td>
<td>Lifetime license</td>
</tr>
<tr>
<td>A trial watermark will be applied to all converted videos</td>
<td>No annoying watermarks</td>
</tr>
<tr>
<td>Audio files are converted or exported only halfway</td>
<td>Unlimited audio conversion</td>
</tr>
<tr>
<td>SuperSpeed conversion only processes ½ length of all video files</td>
<td>Fast SuperSpeed mode for quickly changing video format</td>
</tr>
</tbody>
</table>

### Buy activation key

1. Click the button below to go to the purchase page and click the **Buy Now** button there.
2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase form. **IMPORTANT!** Be sure to enter a valid e-mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from support@movavi.com containing your activation key.

![Buy Activation Key Button]

### Open the activation window

1. Launch **Movavi Video Converter Premium**.
2. Open the **Settings** menu and select **Activate Software**. The activation window will appear.

![Activate Software Window]

### Enter your activation key

1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click **Activate** to verify your activation key.

![Enter Activation Key Window]

If you have entered the key correctly, you should see a message confirming successful activation. Click OK to complete the activation process and restart the program.

### Having problems with activation?

If activation is not working as expected, try the following:

- Make sure that the activation key is entered correctly and is intended for the program you are activating.
- Try **activating offline via e-mail**.
- Contact us at support@movavi.com and we’ll help you solve the problem!

### Activating without Internet access

If the computer you have installed **Movavi Video Converter Premium** on is not connected to the Internet, you can activate the program via e-mail. See detailed instructions

### How to get an activation key

You can get an activation key either from our official website or from any of our partners in your region. Follow the steps below to buy an activation key from the Movavi website:
Go to the purchase page

To open the purchase page for Movavi Video Converter Premium:
- In the Settings menu, choose Buy Activation Key, or
- Follow the link below...

Buy Activation Key

Choose a license type
- If you plan to use Movavi Video Converter Premium at home, click Buy Now on the purchase page to proceed with buying the personal license.
- If you plan to use Movavi Video Converter Premium at work, in a government institution, or gain profit in any way, click Business license on the purchase page.

After that, you will be redirected to an online store depending on your region and the available payment methods. All of our vendor partners are secure and completely safe.

Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.

Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the program.

Get activation instructions
- Activating without Internet access

If you haven't received your activation key within the hour:
- Check the Spam folder of your mailbox
- Contact support

Activating Video Converter

Activating Movavi Video Converter Premium will allow you to remove all of the trial restrictions and use the program forever.

You will need:
Movavi Video Converter Premium activation key. You should receive your key via e-mail right after your purchase is completed. Don't have a key? Buy now
- Internet access. Don't have Internet access? See this guide on offline activation

Open the activation window
1. Launch Movavi Video Converter Premium.
2. Open the Settings menu and select Activate Software.

Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.

If you have entered the key correctly, you should see a message confirming successful activation. Click OK to complete the activation process and restart the program.

Having problems with activation?
- Check that the activation key is entered correctly and is intended for the program you are activating.
- Try offline activation.
- Contact our support team
Activating without Internet access

Activating Movavi Video Converter Premium will allow you to remove all of the trial restrictions and use the program forever. If you don’t have Internet access on your computer, you can use any other computer or mobile device to complete the steps that require a connection.

You will need:

Movavi Video Converter Premium activation key. You should receive your key via e-mail right after your purchase is completed. Don’t have a key? Buy now

- A device or another computer that can be used to send and receive e-mail

Open the activation window

1. Launch Movavi Video Converter Premium.
2. Open the Settings menu and select Activate Software. The following box will appear:

Enter your activation key

1. Enter or paste your activation key into the corresponding field.
2. Select the Activate offline option.
3. Click Activate to proceed to the next.

Send an e-mail with the provided information

The next window contains important activation information that you will need to send us via e-mail in order to activate your program.

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer or device that you will be sending the e-mail from.
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information you’ve copied earlier into the message body and send this e-mail to reg@movavi.com. The activation server will then verify your activation key and send you an automatic response containing a registration key, which you will need to enter into the Activation window. You should receive the server’s reply within an hour.
To ensure a quick reply from our activation server, please do not alter the message subject or body

Enter your registration key
1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.

If everything is correct, you will see a successful activation message. Click Finish to complete the activation and close the activation wizard. Once activation is complete, you may be asked to restart the application.

If you have entered the key correctly, you should see a message confirming successful activation. Click OK to complete the activation process and restart the program.

If offline activation doesn't work:
• Make sure you have entered the activation key and the registration key correctly and try again
• Check that you are activating the right application.
• Make sure you have administrator rights on your computer

If you have any questions or problems while activating your Movavi software, feel free to contact us and we'll help you out!
Our e-mail: support@movavi.com
Click here to open live chat

Converting video
Open the videos
Before you start, you will need to open the videos in Movavi Video Converter Premium.
1. Click the Add Media button at the top and choose Add Video from the pop-up menu.
2. A File Explorer dialog box will open. Select the files you want to convert.
3. Click Open. The files will now be added to the file list.
Choose output format
In the lower half of the window, you will find a list of output formats.
1. Click the Video tab.
2. Click the format you want to use. For example, MOV.
3. Choose the preset with the codec and resolution that you want to use. To convert without changing the resolution, click the line marked "Same as input". For example: "MOV", or "AVI MPEG-4 - Original size"

Customizing presets

Edit and trim video
If you want to edit one of the videos, click the Edit button next to it to open the Editor window.

Editing files

Check output folder
At the bottom of the window, check the Save to box. This is where the output files will be saved. To use a different folder, click the folder icon and select the new output folder.

Changing output folder

Finally, click the CONVERT button to start processing the videos. This may take anywhere from a few seconds to several hours, depending on the size and number of video files.
Converting for social networks

Social networks like YouTube or Facebook don’t accept all video formats. Follow the steps below to convert your videos to a format compatible with the social networks.

Open the videos
1. Click Add Media and choose Add Video from the pop-up menu.
2. A File Explorer window will open. Choose the videos you want to convert and click Open. The videos will be added to the file list.

Choose a social network preset
1. In the lower half of the window, click the Video tab to show all video formats.
2. Use the arrow on the right to scroll through the list and click the Online Video group.
3. Choose the social network and resolution that you want to use. This will set the optimal format and codec settings for uploading to this social network.

Convert and share
1. Click the folder icon next to the Save to box to choose where the output files will be stored.
2. To share the videos right away, click the Upload to button and choose the services that you want to upload videos to.

Note: to upload videos, you will need Movavi Share Online, a free add-on that you can use for batch uploading. If Share Online is not installed, you will be prompted to download and install it.
3. Finally, click **CONVERT** to start converting the videos.

4. If you've selected sharing options, the files will open in **Share Online** as soon as conversion has finished. There, log in to the services, provide a title and description for each video and click **Upload**.

---

**Convert videos for the web**

To upload a video online, whether to a personal website or to a video hosting service, you will need to do two things: convert it into a suitable format and upload it onto the web.

**Open videos**

1. Click the **Add Media** button and choose **Add Video** from the pop-up list.
2. A **File Explorer** box will open. Select the files you want to convert and click **Open**.

---

*How to open videos*
Choose a web preset
1. Click the Video tab for video output formats and presets.
2. Use the arrow on the right to scroll through the list and click the Web-Compatible Video group.
3. In the pop-up list, choose the format and resolution that you want to use.

Convert and upload
Check the Save to box to see where your web-ready files will be saved. To change the folder, click the folder icon. When you're ready, click CONVERT to start processing your videos. When conversion is finished, you can start uploading your files to your blog or website.

Converting DVDs
The era of the DVD disc is coming to an end, and not all homes now have a DVD drive. Make your favorite movies future-proof by backing them up to your computer.

Open DVD
1. Insert the disc into your DVD drive. If you have an external DVD drive, connect it to the computer.
2. Click Add Media in the upper left-hand corner of the window.
3. Hold your mouse pointer over Add DVD.
4. Click the disc name in the menu that appears. If you don't see the DVD in the list, click Open DVD and find the DVD location.
Tip: some DVDs are protected from illegal copying and cannot be converted. Movavi Video Converter Premium is not intended for copying protected media.

Choose video format
1. In the lower part of the window, click the Video tab to see a list of video formats.
2. Choose the group with the format you like.
3. Click that format and pick a video resolution. To convert with the original resolution, choose the line marked with "Same as input".

Choose files and streams (optional)
Many DVDs come with bonus clips, as well as a number of subtitle tracks. Select just the files you need to save disk space:

Bonus files
To remove bonus files that you don’t need, click the icon to the right of the video.

Audio tracks
1. Find the audio information in the right-hand part of the file list and click on it to open the list of audio tracks.
2. Deselect the audio tracks that you don’t want to keep.
Learn more about audio tracks

Subtitles
1. Find the subtitle information in the right-hand part of the file list and click on it to open a list of available subtitles.
2. Choose the subtitle track that you want to keep.
Learn more about subtitles

Convert
The Save to box at the bottom shows where the DVD movies will be saved after conversion. To save the files to a different location, click the folder icon and choose the new destination folder. When you’re ready, click CONVERT start processing the videos.
Creating GIFs from videos

Open a video
1. Click Add Media in the upper left-hand corner of the window and choose Add Video from the pop-up menu.
2. Find the video you want to turn into a GIF and click Open.

Trim the video
Usually, GIFs are pretty short, which means you'll need to trim the video to show just the important part.
1. Click the Edit button next to the video in the file list to open the Editor window.
2. Cut the video as you need.
3. Click Done to finish trimming and close the editor.
Learn more about trimming files

Choose GIF format
1. In the lower half of the window, click the Images tab to see image formats.
2. Click GIF to see GIF conversion options.
3. Choose a size for your animated GIF. For example, "Medium GIF".
4. (Advanced) To change the frame rate, click the Customize button next to the output format at the bottom to customize the selected preset. In the settings window, choose the frame rate you need and click OK. Higher frame rates will make the movements seem smoother, but will increase the GIF's file size.
Save the GIF
1. Take a look at the Save to box at the bottom of the window: this is where the finished file will be created. To choose a different location, click the folder icon and select the new output folder.
2. Click CONVERT to save your animated GIF.

Convert for devices
How to convert video for devices
Each device has specific requirements to the type of video it can play, with some older devices supporting only a handful of video formats. To make sure you'll be able to watch the videos on your device, convert them using the output preset created specifically for your device, and all the necessary output settings will be selected automatically. This way, you don't have to look for what formats your phone supports, as it's all selected for you.

Find your device automatically
If you're converting for a smartphone or tablet, connect the device via USB, and the converter will automatically detect it and recommend the best output format.
Learn more

Add files
Open the files you want to convert.

Open the Devices tab
In the lower half of the window, click the Devices tab so see a list of device presets.

Find your brand
In the Devices list, use the arrows on the left and right to scroll through the list and find your device’s manufacturer and click on it to see a list of device models.

If you don’t see the device’s brand in the list, try the search bar, or use a general category, such as Android, TVs, or Tablets.

### Find your device
Choose your device from the selected brand’s list and click on it to select it as the output format. Now, the format, codec, and resolution is automatically selected to be optimal for your device.

### Convert
Click the folder icon next to Save to to select where you want to save the videos, and then click CONVERT to start processing the files.

After the videos are ready, all you need is to upload them to the device.

* A preset is a pre-made configuration for a specific device that contains all necessary media properties required by this device.

### Device recognition
Converting videos for devices such as smartphones and tablets is quick and easy: all you need to do is connect the device and the program will suggest the recommended format and resolution for it.

### Add files
Drag the files you want to convert onto the converter window.

### Connect the device
Connect the smartphone or tablet to your computer using a USB cord.

### Confirm the device
1. Once the device is recognized, a dialog box will appear with the device name and the recommended preset. Check that the device name matches your device. If the dialog box doesn’t appear, click the Device Detection button to the right of the search bar.
2. If the device is correct, click Use These Settings to use the recommended output format, resolution, and other parameters.
Several devices are listed

Sometimes, the device detection box shows a list of several devices. This can happen if you have more than one connected device, or with some devices that are very similar and can't be identified precisely. In this case, open the Choose your device list and select the device model that you want to convert for. Then, click Use These Settings to use the recommended format, resolution, and other settings.

Device was not detected

• If the dialog box does not appear, try clicking the Device Detection button to the right of the search bar.
• Try reconnecting the device and wait for the system to detect it.
• If that doesn’t help, you can still find a preset for your device manually on the Devices tab. Detailed instructions

The wrong device was detected

If the dialog box shows the wrong device, and that device isn’t also connected to your computer, you can still find it manually on the Devices tab of the preset list. If you want to report this mistake, write to us at support@movavi.com and tell us your device model, and which device was shown instead. Detailed instructions

Convert

1. Click the folder icon next to the Save to box and choose where to store the files after converting.
2. Click CONVERT to start converting the videos for your device.
3. After conversion has finished, upload the videos to your device and enjoy.

Disabling device detection

If you don't want to use device detection for any devices:
1. Click the Settings button and choose Preferences.
2. In the Preferences window, disable the "Recommend output format for connected devices" option.
3. Click OK to apply the changes.
Disabling detection for one device
If you don't want the device detection window to appear whenever you connect a specific device:
2. Select the "Don't show when I connect this device" option and close the window.

Converting audio
Even though MP3 is the most commonly used format, you may also encounter other formats, such as AAC or FLAC, which can preserve audio quality better, but aren't supported by all devices. Converting audio will not only let you play music on any device or player, but also organize and compress your media library.

Open music
1. Click Add Media in the upper left-hand corner.
2. Click Add Audio in the pop-up list.
3. A File Explorer dialog box will appear. Choose the audio files you want to convert. Or simply drag the audio files onto the converter window.
Choose audio format
1. In the lower part of the window, click the Audio tab to see the list of audio formats.
2. Click the format you want to convert the audio to.
3. Choose the bitrate that you want to use. To convert without changing the bitrate, choose the preset marked with "Original bitrate".

**Bitrate** - the bitrate reflects the amount of data in kilobits that is played back each second (measured in kbps). Higher bitrate usually means higher audio quality as well as larger file size, as extra data needs to be stored within the file. For audio presets, the bitrate is listed next to the format. When you convert a file to lower bitrate, the extra bits of data are irretrievably lost, meaning that you cannot increase quality by converting audio to a higher bitrate, because the file no longer contains the data that can be used to restore higher quality.

Edit audio (optional)

**Rename file**
Renaming media files helps keep the music library in order.
1. Click the pencil icon next to the file you want to rename.
2. Enter the file's new name.
3. Click OK.

**Normalize files**
If some of your music files are quieter than others, you can normalize their sound so you don't have to adjust the volume every time you listen to them.
1. Click the Edit button next to the file you want to normalize.
2. The Editor window will open. There, switch to the Audio tab.
3. Adjust the volume level or select the Normalize volume option.
4. Click Done.

**Convert and upload**
1. To change where the files are stored, click the folder icon next to the Save to box and choose the output folder.
2. If you want to upload the music to iTunes after converting, click the sharing button at the top of the window and select iTunes from the pop-up window.
3. When you're ready, click **CONVERT** to start the audio processing. Your files will be ready in a few minutes at most.

**Converting images**

Most applications and web services are limited to just a few image formats, and working with rare formats usually requires expensive software. Convert images to be able to use them wherever you like!

**Open images**
1. Click **Add Media** in the upper left-hand corner of the window.
2. Click **Add Images** in the pop-up menu.
3. Choose the images you want to convert and click **Open**.

**Choose format**
1. In the lower half of the window, click the **Images** tab to see a list of image formats.
2. Click the format you want to use.

*Note: not all formats support transparency. If the images have transparent areas, choose the PNG or BMP format.*
Reduce the file size (converting to JPG only)
Click the file size to open settings, then drag the slider to reduce the image size.

Edit image (optional)
You can quickly fix or improve any images before converting. To do that, click the Edit button next to the image you want to adjust.

Resize images (optional)
To batch resize the images:
1. At the bottom of the window, click the cogwheel icon next to Output format.
2. Click the box under Frame size and choose a size that you want to use for all images, or choose any of the following and enter the size into the width and height boxes on the right:
   - Custom: scales the images to exactly the size you specify.
   - Smart fit: scales the images up or down as close as possible to the specified size without changing the proportions.
   - Up to size: scales the images down as close as possible to the specified size without changing the proportions. Images smaller than this size will remain unchanged.
   To allow changing the image proportions, click the link icon next to the width and height boxes:  - locked,  - unlocked.
3. If the new size is different from the original image proportions, choose a resize method for your images:
   - Letter box – unused space will be filled with black.
   - Stretch – the image will stretch to fill the entire area.
   - Crop – the image will be resized to fill the entire area, and overflowing edges will be cut off.
3. Click OK to accept the changes. If you want to preview the result, click the Edit button next to an image.
Convert

1. Check the output folder in the Save to box. To change where the files are saved, click the folder icon next to it.
2. Click CONVERT to start processing the images.

Opening media

To begin converting media files, you will first need to open them in Movavi Video Converter Premium.

Add media

1. Click Add Media at the top of the window.
2. Click one of the buttons to open files of that media type.
3. A File Explorer window will open. Find the files you want to convert and click Open to add them to the queue. Or simply drag the files from any File Explorer window onto Movavi Video Converter Premium to add them to the queue.

File list

After you have opened the files, they will all appear in the file list. Here, you can view information about the files, choose audio and subtitle tracks, and manage the output file.

On the left, you can see the file's media information, and on the right you can manage the output file's name, media streams, and edit the file. To remove a file from the list, click the X button on the right.
Media streams

Every media file is made up of streams for each data type. A video can contain a video stream, a couple of audio streams, and several subtitle streams. When converting files, you can find the information about these streams in two columns on the right. Here, you can manage the streams that end up in the output file.

Compress video
You can compress a video to reduce its output file size by sacrificing some of the quality. To do that, click the output file size and move the slider to the necessary file size while keeping an eye on the quality.

Choose audio tracks
If a file comes with a number of audio tracks for different languages, you can keep just the ones you need. To do that, click the audio stream and deselect the audio tracks that you don’t want to keep.

Choose a subtitle track
When you convert videos, you can permanently overlay subtitles on top of the video. To do that, click the subtitle stream and choose or add the subtitle track that you want to use.

Information about the original file
To find detailed information about the video and audio streams of the original file, right-click anywhere on the file and choose File Information from the pop-up menu.

Open audio track list
In the rightmost column of the file list, click the audio track information box. The audio track list will appear.

Choose audio tracks
In the box with the audio tracks, deselect the audio tracks that you don’t want to appear in the output video. If you want to completely remove audio from the file, select the No Audio option. You can remove audio from all the files in the list by checking the Apply to all files box. You can also apply an audio track to all files.
Choosing a subtitle track
When you convert videos, you can permanently overlay any subtitle track onto the original video. This can be useful if you’re watching videos on a device, or your player doesn’t support subtitles.

Open the subtitle list
In the rightmost column of the file list, you can see the subtitle and audio track information for each file. Click the information next to the subtitle balloon to open the list of subtitles.

Choose a subtitle track
In the subtitle list, click the subtitle track that you want to use. You can choose soft or hard subtitles.

Adding subtitles from file
To add your own subtitles that aren’t stored inside the original file, click the Add button above the subtitle list and then open the subtitle file that you want to add. You can use *.srt, *.ass, or *.ssa subtitle files.

Subtitle encoding
If the subtitle text looks scrambled, open the Subtitle encoding box and try setting the encoding with the right language.
Applying a subtitle track to all files
Choose a subtitle track and select **Apply to all files**. This function works only in case you have files with the same quantity of subtitle tracks, for example, it is a series.

Preview the subtitles
Click the **Edit** button to see how the subtitles appear on the output video. For more subtitle editing options, click the **Subtitles** tab, where you can edit the subtitle position and timing.

Extract audio from video
You can quickly save your favorite song from any movie by converting the video to an audio format.

Open the video
Open the video file that you want to extract the soundtrack from.

Trim the file
If you only need a short part of the soundtrack, you can cut off the rest of the file:
1. Click the **Edit** button next to the file or select **Trim** in the **Tools** tab.

2. On the **Trim** tab, cut a fragment moving, trimming markers.
3. Click the trash can icon to delete.
4. Click **Done** to accept the changes and close the editing window.

Choose an audio format
1. Click the **Audio** tab in the lower half of the window.
2. Click the audio format you want to use.
   - If you're not sure, use the MP3 format: it is supported by most players and allows for a decent quality.
   - If you want to convert audio with multichannel sound, you can use WAV, OGG, or FLAC formats.
3. Choose the necessary bitrate (quality) from the pop-up list. Choose **Original bitrate** if you want to keep the original quality.
Compressing videos
Compressing videos can help reduce the size of the output file by reducing their bitrate. When you compress a video, it loses some of its original quality, but even a small bitrate reduction can make the file significantly smaller.

Add files
Open the files you want to compress.

Choose the output format
The video's format and resolution play a very important role in the output file size.

1. Click the Video tab to see a list of video formats.
2. Click the format you want to convert the videos to.
Note: Some formats and codecs compress video better than others. If you're not sure which format to choose, use the MP4 format with the H.264 codec for the best size to quality ratio.
3. From the format list, choose the resolution that you want to use.

Choosing the resolution
A video’s resolution is the number of pixels in every frame. A higher resolution can preserve more information and quality, but it also requires more disk space. Select a slightly lower resolution if the video is very large. For example, you can convert 1080p videos to 720p.
Learn more
Compress video

1. In the file list, check the file's output size in the second column from the left.

2. Click the file size information to show compression options. There, choose the bitrate type.

   **Constant bitrate (CBR)** allows you to get an output file with the exact size (recommended for DVD recording and streaming). During CBR encoding, the bitrate or the number of bits per second is kept the same throughout the encoding process.

   ![Constant bitrate (CBR) example]

   **Variable bitrate (VBR)** allows you to reduce output file size up to two or three times saving the quality. But the file size cannot be predicted. During VBR encoding process the bitrate of the media file will dynamically increase or decrease depending on the media files bitrate needs. Use VBR unless you have a specific need for playback on a device that only supports CBR.

   ![Variable bitrate (VBR) example]

3. Click **Apply bitrate to all files** in the compression box if you want to unify quality of the files.

   If you want to check the quality of the output file without converting the whole file, click the **Convert sample** button. You can set the duration of the fragment to the right of the button. The folder with the converted fragment will be opened automatically.

   **Convert**
   
   Click **CONVERT** to start processing the compressed file.

   ![Convert button example]

**Media information**

In the leftmost column of the file list, you can see the general information about the file, including its original size, video codec, resolution, and bitrate.
To get more details, right-click the file and choose **File Information** from the pop-up menu. Here, you can see all the information about the original file’s video and audio streams.

**Choosing output format**

After you’ve added media files, it’s time to choose the output format for converting all of the files in the list. Follow the steps below to choose a video output format.

1. In the lower half of the window, click the **Video** tab to see a list of video formats.
2. Click the video format that you want to convert the files to. A list of presets for this format will appear.
3. Choose the video codec and resolution that you want to use.

*To convert without changing the resolution, choose the preset marked with “Original size” or “Same as input”.*

Each preset displays information about the video, audio, and other output parameters that can help you choose the right one.
Choosing the right resolution

A video’s resolution is its size in pixels, horizontally and vertically. It is usually listed as the width times height: 1920x1080, or just the height: 1080p. This means that the video is 1920 pixels long and 1080 pixels tall. The higher a video’s resolution, and the more pixels it has, the more detail it can preserve.

First of all, you need to know the original file's resolution. To do that, check the video information next to the file’s preview. When you choose the output resolution, select the same resolution to preserve the original quality, or choose a lower resolution to reduce the file size.

Advanced settings

If you can't find a suitable preset, you can select the necessary properties manually. Click the Customize button next to the 'Output format' box to modify the video and audio properties of the currently selected preset.

Learn more

Customizing presets

After selecting a preset, you can manually modify it to change any output properties. To do that, click the cogwheel button next to the Output format box to open the settings for the selected preset.

To see more settings, click Show Advanced at the bottom of the settings window.

Two Pass Encoding

Encoding videos in two passes means that the encoder will go over the media file twice: first, to analyze the file and then to convert it using the collected data. This takes extra conversion time, however it allows for a higher output quality and possibly a slight reduction in file size.

To enable two pass encoding:
1. Inside the Settings window, click Show Advanced to show the encoding settings.
2. Under Encoding type, choose Two Pass.
3. Click OK to accept the changes.

Tune settings

You can use Tune for advanced settings of H.264 videos.
Tune optimizes the preset settings for the best quality depending on the type of the input video:

- Film – for action movie content
- Animation – for animated cartoons
- Grain – for grainy, detailed video material
- Stillimage – for still image footage
- PSNR – for achieving high peak signal to noise ratio
- SSIM – optimization for structural similarity
- Fast Decode – for faster decoding
- Zero Latency – for streaming video.

Editing media files
If you need to make some quick edits to the file before converting, click the Edit button next to the file that needs editing or Tools, and then apply the necessary adjustments in the editing window.

Trimming videos
If you only want to convert a part of the video, you can trim off the parts you don't want from the beginning and end of the file. Learn more about trimming videos

Joining videos
If your video footage is in several different files, you don't need to use a full-function video editor to join them together. Learn more about joining files
Flipping and rotating videos
Nobody likes videos with the wrong orientation! This can be easily fixed with the Transform Video tool which lets you rotate and flip videos or images.
Learn more about transforming videos

Cropping videos
Cropping a video can change the video's aspect ratio to remove any black bars around it; you'll be able to use the entire screen when watching the video. Cropping a video or image can also help to remove unwanted images from the edges of the screen (for example, if there's a dumpster at the edge of an otherwise beautiful video!) or draw attention to the center of the frame.
Learn more about cropping

Changing the aspect ratio
Changing the video's aspect ratio also lets you to make full use of available screen real estate without black bars. This is particularly useful if you want to watch old TV-format videos on a new 16:9 screen, or vice versa.
Learn more about aspect ratios

Adding a watermark
Adding your name or logo on top of the video will make sure nobody else can take credit for your videos.
Learn more about watermarking

Adjusting colors
Using Movavi Video Converter Premium, you can make quick color adjustments to your videos and photos. Use automatic adjustments for fast enhancement, or adjust the hue, brightness, and saturation manually.
Learn more about video adjustments

Stabilizing video
If your videos have a lot of camera shake, you can reduce the effects using video stabilization.
Learn how to stabilize video
Enhancing audio
Many movies have problems with volume, where the dialogue is too quiet and action scenes blast at full volume. To combat this, you can normalize the file's audio track using Movavi Video Converter Premium, or adjust the volume level manually. Learn more about audio enhancements

Adding effects
You can add effects to your video! Video Converter has some simple effects as removing fish eye, sharpening, vignette, and more. Learn how to add effects

Before and after effects
After you've edited the file, its thumbnail will now be marked with a magic wand icon. You can click it to see a list of applied effects. To remove adjustments, select it in the list and click Remove.

Trimming files
Enter edit mode
Click the Edit button next to the file you want to trim or select Trim in the Tools tab.

Cut out a part of the video or audio:
Method 1
1. Select the fragment you want to cut out by setting the trim markers.
2. Click the trash can to remove it.

Method 2
1. Press to Play the video.
2. When the fragment you want to cut out begins, set the left trim marker.
3. When the fragment ends, set the right trim marker.
4. Click the trash can to remove it.

**Method 3**
To set the exact time, type in values in the number input field and spin the time units as needed. Video plays parallel to the time change in the fields.

Repeat this for all other fragments that you want to remove. When you remove fragments, the rest of the video will seamlessly snap together.

**Exit edit mode**
When you’ve removed all the parts you don’t need, click **Done** to close the editing window.

**Cancel trimming**
If you want to remove the trimming and go back to the original length, click **Reset** on the Trim tab in the editing window.

**Trim without conversion**
You can trim a file and save it without conversion. The Trim without conversion option is available only for videos with H.264 codec and audio with no applied tools except for trimming.
To do this, take the steps above to rotate a file and then click **Save without conversion** button.
When the saving finished, click **Done**.

If you have any tools applied, click the broom icon and then Reset applied tools. The **Save without conversion** button will be available.
Rotating video

Enter edit mode
Click the Edit button next to the file you want to rotate or select Rotate in the Tools tab.

Rotate or flip the file
1. Click the Rotate tab at the top of the editing window to show rotation options.
2. Click one of the buttons to rotate or flip the file. The rotation buttons will rotate the file by 90 degrees with each click.

Exit edit mode
1. Click Apply to confirm the changes. If you want to rotate or flip all of the files in the same way, select the Apply to all files option.
2. Finally, click Done to close the editing window. Now, you can proceed to converting the files.

Saving without conversion
You can rotate a file and save it without conversion. The Rotate without conversion option is available only for MP4, MOV, M4V-files with no applied tools. To do this, take the steps above to rotate a file and then click **Save without conversion** button. When the saving finished, click **Done**.

![Rotate and Flip](image)

If you have any tools applied, click the broom icon and then Reset applied tools. The **Save without conversion** button will be available.

![Reset applied tools](image)

### Cropping video

Cropping a video can help you remove parts around the edges or fix the video’s aspect ratio.

#### Enter edit mode

Click the **Edit** button next to the file you want to crop or select **Crop** in the **Tools** tab.

![Edit](image)

#### Crop your file

Set the crop frame to the necessary size and position:

1. Drag the edges of the frame to change its size, and drag by the center of the frame to move it relative to the entire video.
2. If you want a specific size, enter it into the **width** and **height** boxes.
3. If you want to crop the video to a specific aspect ratio, make sure that the **Maintain aspect ratio** option is enabled and choose the proportions from the box below.

**Exit edit mode**
1. Click **Apply** to accept the changes.
2. Click **Done** to close the editing window, and then convert the files for the changes to take effect.

**Adding effects**

**Enter edit mode**
Click the **Edit** button next to the file you want to apply effects to or select **Effects** in the **Tools** tab.

**Apply effects**
Click the preview icon to add an effect. You can apply several effects simultaneously.

**Exit edit mode**
1. Click **Apply** to accept the changes. If you want to batch-process your files, select **Apply to all files** to apply the same effects to other files in the list.
2. Finally, click **Done** to close the editing window.

Adding a watermark
Use the watermarking tool to overlay any text or image over your videos and images.

**Enter edit mode**
Click the **Edit** button next to the file you want to apply a watermark to or select **Effects** in the **Tools** tab.

**Apply the watermark**

**Text watermark**
1. On the Watermark tab, click the **Text** button.
2. Enter the watermark text into the box.
3. Click the buttons under the text box to change the font, text color, and outline color.
4. Move the **Transparency** slider to make the text more see-through.

**Image watermark**
1. On the Watermark tab, click the **Image** button.
2. Click the folder icon and choose the watermark image you want to use.
3. Move the **Transparency** slider to make the image see-through and less distracting.
4. By default, the image will keep its original proportions. To change the proportions, deselect the **Maintain aspect ratio** option.

**Move the watermark**
In the player, move the watermark to the necessary position.
1. Drag at the corners to change the size of the watermark.
2. Drag at the center to move the watermark.

**Exit edit mode**
Click **Apply** to accept the changes. If you want to batch-process your files, select **Apply to all files** to apply the same watermark to other files in the list.
Editing subtitles

Using the subtitle tool of the converter, you can permanently overlay a subtitle stream onto a video (also called ‘hardsub’). This can be helpful if you’re planning to watch the videos on a mobile device or using a player that does not support separate subtitle tracks.

Enter edit mode

Click the Edit button next to the file you want to overlay subtitles to or select Subtitles in the Tools tab.

Choose the subtitles

You can choose soft or hard subtitles.

**Softsubs** are stored as a separate track and you can add several subtitle tracks to one file. All the subtitle tracks will be saved if you choose this option.

*Note*: Not all formats support softsubs. There are also less editing options: you can’t change position and synchronize them with video. They are also not displayed in the preview window.

**Hardsubs** are permanently drawn on top of the video and cannot be turned off, but they are guaranteed to be visible in any player.

- If the subtitles are built into the file, select the necessary subtitles from the list.
- If the subtitles are stored as an external file, click Add and open the subtitle file. You can use *.srt*, *.ass*, or *.ssa* subtitle files.

Set up the subtitles:

**Subtitle encoding**

If the subtitle text looks scrambled, try changing the subtitle encoding: open the list and choose the language or character set the subtitles should be in.

**Position**

Use the Position box to change where the subtitles appear on the screen:

1. Open the Position box and choose which edge the subtitles should snap to (e.g. top or bottom).
2. Use the slider below to move the subtitles relative to the selected position.

**Synchronization**

If the subtitles are out of sync with the video, use the synchronization box to advance or delay subtitles by a specific time in seconds and milliseconds. Positive values make the subtitles appear later, and negative values make them appear earlier.

*Example:*

-0.100 – the subtitles will appear 100 milliseconds sooner.
1.200 – the subtitles will appear 1 second and 200 milliseconds later.
Exit edit mode
Click Done to apply the changes. When you convert the video, the selected subtitles will be permanently shown over the video.

Extracting subtitles
1. Click on the subtitles field next to the video you want to extract subtitles from.
   • Make sure to choose the video format.
2. In the pop-up menu, click the Extract subtitles into a separate file button.
   • Now, the file with the extracted subtitles will be saved by default in Movavi Library folder.
   • The file will be automatically shown in folder at the end of the extracting process.

Adjusting colors
Enter edit mode
Click the Edit button next to the file your file and switch to Adjustments tab or select Adjustments in the Tools tab.

Adjust the colors:
1. Drag the sliders to change the brightness, contrast, hue, and saturation of the photo and video.
2. Auto contrast option sets up brightness and contrast of a video or photo.
3. Use the Magic Enhance option the automatically fix the brightness, contrast, and saturation of the video or photo.
4. If the colors look unnatural, try the Auto white balance option.
Exit edit mode
1. When you’re satisfied with what you see in the preview, click Apply. To batch-process other files in the list with the same adjustments, select Apply to all files.
2. Finally, click Done to close the editing window.

Video noise removal
Noise can appear on photos and videos if they were taken in poor lighting conditions. Follow these instructions to remove noise from any videos or photos.

Enter edit mode
Click the Edit button next to the file you want to adjust or select Adjustments in the Tools tab.

Remove noise
1. Select the Noise removal option.
2. Move the Noise level slider to reflect the amount of noise you can see in the preview. The more noise you need to remove, the higher the Noise level.
Exit edit mode
1. When you’re satisfied with the result, click **Apply**. If you need to remove noise from several similar files, select **Apply to all files** to use the same noise level on all the files in the list.
2. Click **Done** to close the editing window.

Enhancing audio

Enter edit mode
Click the **Edit** button next to the file your file and switch to the **Audio** tab or select **Audio** in the **Tools** tab.

Adjust the volume
1. To change the volume of the whole file, drag the **Volume** slider to the necessary level, where 100% is the original volume.
2. If parts of the file are too quiet, select the **Normalize volume** option to make them louder.
Remove noise
1. Select the **Remove noise** option.
2. Drag the **Noise level** slider to set the amount of noise you can hear in the file.

Exit edit mode
1. When you’re finished, click **Apply** to accept the changes. To fix the volume for all the files in the list, select **Apply to all files**.
2. If you don’t need any further editing, click **Done** to close the editing window.

Low volume detection
When you add files to the converter, it will check the volume of the files and recommend steps if the volume is too low.

Find low volume files
The converter will mark quiet files with the "**Low volume**" tag. Click the tag to see the recommended course of action.

Boost volume
A message will appear, recommending volume adjustment. Click Boost Volume in the message to open the audio adjustments.

The Normalize volume option will already be selected for you. Play the file to check the new volume level. If you need more volume adjustment, use the Volume slider to set the necessary volume level. Click Apply once you’re satisfied with the new volume.

Exit edit mode
When you’re finished, click Done to return to the main window.

Stabilizing video
Videos shot on handheld cameras often look shaky and unstable, no matter how hard you try to keep the camera level, especially if you’re filming sports using a portable action camera such as a GoPro®. To remove camera shake from your videos:

Enter edit mode
Click the Edit button next to the file your file and switch to the Stabilization tab or select Stabilization in the Tools tab.

Set up stabilization
Set up stabilization with the following parameters depending on the video and the amount of shaking:

Accuracy: affects the analysis precision of the video. Higher accuracy yields the best results, but also takes more time.

Shaking: set how strongly the shaking is visible on the video.

If you need more advanced settings, click the arrow under the sliders.
Radius: when a video is stabilized, each object is adjusted using the pixels from the surrounding area. The radius affects how large that area will be. Use a smaller value for more dynamic videos to avoid mixing objects together and to preserve more detail.

Smoothing: limits camera acceleration. Higher values work best for more or less static videos. Excessive smoothing may limit panning.

Edge Cropping: after compensating for motion, some distortion artefacts like blurred areas may appear around the edges.
- None: the edges will remain as they are. Best results if there is little shaking on the video.
- Fixed: the video is cropped to one size to cut off some of the edges.
- Adaptive: whenever there is a lot of shaking, the video will zoom in so that the distorted edges are not shown.

Exit edit mode
Click Apply to accept the changes. If you have several similar files, select Apply to all files to stabilize them in the same way. If you're finished editing the file, click Done to go back to the main window. Stabilization will only take effect after you convert the videos.

Merging files
Click Add Media in the upper left-hand corner and choose Add Video from the pop-up menu. Open the files you want to merge.
Merge files
The files will appear in the joined video in the same order as they are shown in the list. Drag the files with your mouse to the right order. Select the **Merge files** option at the bottom of the window. All the files in the list will now be queued for merging.

Rename the output file
The output file will have the same name as the first file in the list. To change the name:

1. Click the pencil icon at the top of the file list.
2. Enter the new name in the **Output file name** box.
3. Click **OK**.

Convert
1. Select an output format for the new video. See also: [Choosing output format](#).
2. Click the folder icon next to the **Save to** box and choose where to save the output video.
3. Click **CONVERT** to start joining the files.

**Troubleshooting**
If you see an error after selecting the Join files option, make sure that all of the files in the list have the same number of audio tracks. Click the audio information and disable the extra audio tracks. See also: [Choosing audio tracks](#)

**Renaming files**
Before you convert files, you can change the name of each output file.

1. Click the pencil icon next to the output file name in the second column of the file list.
2. Enter the new name into the **Output file name** box.
3. Click **OK** to accept the changes.

Now, the output file will be converted with this name.

**Fixing the aspect ratio**
Sometimes, when you watch videos on a display with different proportions, you may experience stretching or black bars around the edges. To prevent that, you can change the video's proportions to adapt it to the display beforehand.

**What is the aspect ratio?**
A video's aspect ratio is the ratio between its width and height. The two most commonly used aspect ratios are 4:3 and 16:9, the former used by most analog television broadcasts, while the latter, also referred to as widescreen – in films, DVDs, and modern HD video.

**Enter edit mode**
Click the **Edit** button next to the file your file and switch to the **Crop** tab or select **Crop** in the **Tools** tab.
Fix the aspect ratio
Make sure that the **Maintain aspect ratio** option is selected and choose your display's aspect ratio. This will set the crop frame to these proportions.

In the player, drag the frame's edges so that it covers as much of the video as possible. Drag the frame to the center of the video.

Exit edit mode
Click **Apply** to accept the aspect ratio changes, and then click **Done** to close the editing window.

Before/After mode
You can apply tools and compare an original video and a changed one. To do this, apply any tool and use the **After** and **Before** buttons under the player window.
Changing output folder
When your files are converted, the new files will be created in the folder listed in the Save to box at the bottom of the window.

To change where new files are stored, click the folder icon next to the Save to box and choose the folder you want to use.

If you want to save the new files in the same folder as the original files, click the arrow on the Save to box and choose Save converted files next to the originals.

Sharing and exporting
After the files are converted, you can easily share them with your friends and family on the Internet.

Before you start
To upload files online, you will need the free Share Online application installed on your computer. Download Share Online

Prepare the files
1. Open the files you want to convert. Opening media
2. Choose an output format. Choosing output format
3. Edit the files. Editing media files

Select services for uploading
1. Click the sharing button at the top of the window.
2. Click YouTube, Facebook in the pop-up list.
3. Another list will appear. Select the services or websites where you want to upload your files.
Convert files
Click **CONVERT** to start processing your files. When conversion is finished, the Share Online window will open with the new files, ready to upload.

Upload files
If you haven't used Share Online before, you will be asked to log in to the websites you've selected. *Share Online uses the services’ own authentication and does not store your login data to keep your privacy safe.*

1. In the Share Online window, click a file in the list. Information about this file will appear on the right. Fill in the title, description, and privacy settings for the selected websites. Repeat this for all files in the list.
2. Click **Upload to** to start uploading the files to the selected services.

Uploading files to iTunes
Adding converted videos and music to your iTunes library will allow you to play them on any of your devices connected to the same iTunes account.

Before you start
To upload files to iTunes, you will need iTunes 6.0 or higher installed on your computer.

Prepare the files
1. Open the files you want to convert. *Opening media*
2. Choose an output format. *Choosing output format*
3. Edit the files. *Editing media files*

Choose iTunes uploading
1. Click the sharing button at the top of the window.
2. Select **iTunes** from the pop-up list.
Convert files
Click CONVERT to start processing your files. After conversion is completed, the files will be uploaded to your iTunes cloud storage.

iTunes® is a trademark of Apple Inc.

Energy-saving options
If you are running a batch conversion for very large files, the process may take a while even on fast computers. The energy-saving options allow you to shut down or hibernate your computer after it is done converting the files.

1. Click the Settings button in the upper right-hand corner of the window.
2. Click the When finished menu to see the energy-saving options.

3. Select one of the following:
   - **Do nothing** – the conversion will run as usual, and your computer will stay on.
   - **Hibernate** – your computer will hibernate after conversion is completed. We recommend that you close any other applications that may prevent your computer from shutting down.
   - **Shut down** – your computer will turn off after conversion is completed. We recommend that you close any other applications that may prevent your computer from shutting down.

If you change your mind, you will be able to disable shutdown or hibernation during conversion. Please note that if you use any of the energy-saving options, iTunes and web uploading will be temporarily disabled. The next time you start the converter, the energy-saving options will be automatically turned off.
Watch Folder

The Watch Folder option can monitor a folder for changes and convert any new files to the format of your choice. If you frequently convert videos to one format, you will only need to set it up once and then simply take the converted videos whenever you need them.

Setting up automatic conversion:

Choose a format
Before you set up a Watch Folder, select the format that you want to convert the files to.

Choosing output format

Open Watch Folder options
Click the Tools button at the top of the window and select Watch Folder to see folder monitoring options.

Choose a folder
In the Watch Folder window, click the Browse button next to the 'Monitor folder' box and choose the folder you want to monitor and convert files from.

For example, this can be your downloads folder if you want to convert any new videos you download.
Set up conversion options

In the **After conversion** option, choose what you want to happen to the original files after they've been converted:
- **Delete original files**: the files will be deleted as soon as they are finished converting.
- **Move original files to a subfolder**: the original files will be moved to the 'Originals' folder inside the monitored folder. These files will not be converted a second time.

**Launch at system startup**: enable this option if you want the folder monitoring to resume after you restart the computer.
**Show conversion notifications**: select this option if you want to be notified every time a file has finished conversion or if there's an error.

**Start monitoring**
Finally, click **Start Watch Mode** to begin monitoring the selected folder. The converter window will be minimized to tray and keep working in background mode.
Conversion log:
If you've already used Watch Folder, you can see a detailed list of all conversion events that occurred in Watch Folder mode. To do that, open the Watch Folder window and click View Log at the bottom. Here, you can see whether all files were converted correctly. If you want to keep this log as a text file for future reference, click Save Log and choose a location for saving the log file. To delete all previous entries, click Clear Log.

Accelerating conversion
Here are some things you can do to convert videos even faster.

Take advantage of your hardware
Movavi Video Converter Premium is optimized for the latest hardware, allowing you to use your computer’s full potential when converting videos.

Enabling acceleration
To enable these acceleration options, click the Settings button in the converter window, and choose Preferences from the pop-up menu. In the preferences, switch to the Acceleration tab and select the available acceleration options.
SuperSpeed conversion

SuperSpeed mode allows you to convert video files much faster than usual without losing any quality. When you convert videos, encoding the video from one codec to another takes the most time. If you don’t need to change the video codec or resolution, the video data can simply be copied to the new file, without having to convert it. This is also sometimes called remultiplexing or remuxing.

When can it be used?
SuperSpeed mode can be used any time when the video stream in the output file is the same as the original:
• The output codec is the same as the video codec in the original file (e.g. when converting MKV files with the H.264 codec to MP4 files with the H.264 codec)
• The output resolution is the same as the original
• No video adjustments are used. This includes stabilization, video adjustments, denoising, subtitles, watermark, crop, and rotation.
• No video compression is used.
• You can still enjoy SuperSpeed conversion when trimming files.

How to use SuperSpeed conversion
To use SuperSpeed conversion mode, choose output presets marked with the SuperSpeed badge:
This can be a video format or a device preset that has the same codec and resolution as your original files.

**Intel Hardware acceleration**

If you have one of the latest Intel processors, you can use the built-in graphics chip to accelerate conversion of H.264 and MPEG-2 video.

**Intel hardware acceleration**

- Accelerates video processing by up to 400% when converting H.264 and MPEG-2 video codecs.
- This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
- When choosing an output format, look for presets marked with the Intel HD GRAPHICS badge.

**Compatible processors**

Intel hardware acceleration is available on Intel® Core™ i3, i5, and i7 processor series. For a full list of processors that support integrated graphics, please consult the Intel support center.

**How to use Intel acceleration**

You can enjoy Intel acceleration when converting videos to H.264 and MPEG-2 codecs. When selecting an output format, choose formats and presets marked with the Intel® HD GRAPHICS badge. Conversion to these output formats will be accelerated.

---

**Troubleshooting:**

*Can't enable Intel hardware acceleration*

If the Intel hardware acceleration option in Movavi Video Converter Premium preferences is unavailable:

- Check that your processor is compatible with Intel hardware acceleration. To do that, open the Control Panel, go to System and Maintenance, and choose System. Find the processor information and make sure that you have an i3, i5, or i7 Intel processor.
- Update the Intel processor drivers. You can find the newest version at Intel’s official website here. We recommend only downloading drivers and other software from trusted sources.
- In order for the graphics acceleration to work properly, there needs to be a monitor connected to the graphics card port. Connect the monitor and make sure it is functioning properly, then try enabling Intel® hardware acceleration again.

*Problems while converting using Intel® hardware acceleration*

If the video conversion process is taking longer than expected, or there are defects in the output video file:

- Try updating the processor drivers. You can find the newest version at Intel’s official website here.
- Try disabling Intel acceleration in the preferences.

---

Intel HD Graphics is a trademark of Intel Corporation.

**NVIDIA Hardware acceleration**

If you have one of the latest NVIDIA® graphics cards, you can use its graphics processing power for converting videos. Using the graphics card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.

**Convert using NVIDIA GPU**

- With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50% faster.
- Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other programs.
- This option is only available if your computer is equipped with an NVIDIA graphics card that supports CUDA™ or NVENC™.
- When choosing an output format, look for presets marked with the NVIDIA NVENC or NVIDIA CUDA badge, depending on the acceleration technology supported by your graphics card.

**How to use NVIDIA acceleration**

NVIDIA acceleration works when converting any videos to AVI, MP4, FLV, MOV, or MPEG-2 TS formats with the H.264 codec. To accelerate conversion, choose one of these output formats marked with the NVIDIA CUDA or NVIDIA NVENC badge.
Compatible graphics cards
NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®’s official site: NVIDIA CUDA supported GPUs | NVIDIA NVENC supported GPUs

Note: NVIDIA acceleration does not support mobile graphics cards.

Troubleshooting

How do I find out which GPU my computer has?
1. Right-click on your desktop and choose Display Resolution
2. In the Display Resolution window that appears, click Advanced. This will open your GPU’s properties.
3. In the Adapter type section, you can see your GPU’s model.

The Enable NVIDIA GPU Acceleration option is unavailable
If you can’t enable NVIDIA acceleration, try updating your graphics card drivers.

Problems while converting video with NVIDIA GPU acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
• Try updating the graphics card driver. Detailed instructions
• Try disabling NVIDIA GPU acceleration on the Acceleration tab of the preferences.

AMD Hardware acceleration
If you have one of the latest AMD graphics cards, you can use its graphics processing power for converting videos. Using the graphics card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.

AMD hardware acceleration
• Accelerates video processing by up to 2,5x when converting to H.264 and H.265 video codecs for heavy files.
• This option is only available if your computer is equipped with AMD graphics card that supports the Video Coding Engine technology.
• When choosing an output format, look for presets marked with the AMD Video Coding Engine badge.

Compatible graphics cards
When using the H.264 codec, acceleration will work with graphics cards released after April 2014. When using H.265, it will work with graphics cards released after May 2015.

Troubleshooting

How do I find out which GPU my computer has?
1. Right-click on your desktop and choose Display settings
2. In the Display settings window that appears, click Advanced display settings. This will open your GPU’s properties.

The Enable NVIDIA GPU Acceleration option is unavailable
If you can’t enable NVIDIA acceleration, try updating your graphics card drivers.
AMD Driver Download Center | Detailed Instructions

Problems while converting video with AMD acceleration
If the video conversion process is taking longer than expected, or there are defects in the output video file:
• Try updating the graphics card driver. Detailed instructions
• Try disabling AMD acceleration on the Acceleration tab of the preferences.

Saving a snapshot
To save a single frame from the video:
1. Click the Play button on the video’s thumbnail in the list to view the original file.

![Image of video player with snapshot feature]

2. In the player window, move to the frame you want to save and click the Take a Snapshot button.

![Image of video player with snapshot taken]

3. A File Explorer window will open. Choose where you want to save the snapshot and click Save.
The snapshot will be saved with the original video’s size and quality.

Movavi Video Converter Settings and Preferences
To open the converter preferences, click the Settings button at the top of the window to open the settings menu. There, click Preferences.
The preferences are organized into tabs at the top: General, Conversion, and Acceleration. Click the related tab to find the preferences you need.

**General preferences**

On the General tab of the preferences, you can choose the interface language and control how the application behaves.

**Automatically check for updates** – select this option and you'll be notified whenever a new version is available. Updates within your version are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

**Send anonymous usage stats to Movavi** – checking this box will allow the program to send usage statistics to our development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only. [Learn more about how we use the statistics](#) [Read our Privacy Policy](#)

**Recommend output format for connected devices** – when you connect a smartphone or tablet, the program will detect the device and recommend the optimal format for watching videos on it. [Learn more](#)

**Use software OpenGL implementation** – this option can be useful if your computer doesn't support the necessary OpenGL version and you see an error message when you start the program.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If the program works without showing an OpenGL error message, this option is not recommended. [Learn more about OpenGL troubleshooting](#)

**Minimize to Watch Folder mode instead of closing** – if you have enabled Watch Folder, closing the converter window will minimize the program to the notification area, where it will still be monitoring the folder and converting files. [Learn more](#)
Conversion preferences

On the **Conversion** tab of the preferences, you can manage how files are converted.

Under **Output file name**, you can choose what happens if a file with the same name already exists in the output folder:

- **Overwrite existing file**: the old file will be permanently replaced with the newly converted file.
- **Automatically rename files**: new files will be automatically renamed, and both files will be preserved.

Under **After conversion**, you can choose what happens when conversion is finished:

- **Open output folder**: shows the converted files in the output folder.
- **Play notification sound**: the program will notify you when it has finished converting your files.

Acceleration preferences

On the **Acceleration** tab of the Preferences, you can accelerate conversion using the latest technologies. You can find out more about each acceleration method in the [Accelerating Conversion](#) section.
Troubleshooting
If acceleration options are unavailable:
• Your computer might not have the right hardware.
• If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

Intel HD Graphics is a trademark of Intel Corporation.
NVENC and CUDA is a trademark of NVIDIA Corporation.

Help and support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team.

You can contact us using:
E-mail: support@movavi.com – guaranteed response in 3 business days
Live Chat – available 12 A.M. – 6 P.M. GMT \ 4 P.M. – 10 A.M. PST
Or use the contact form

Please describe your problem in as much detail as possible; any screenshots, log files, or information about your system will allow us to help you faster.
How to take a screenshot | How to collect log files | How to find system information

Frequently asked questions:
Why is "Trial Version" written on my videos?
The watermark is only placed on videos in the trial version. Buy an activation key and use it to activate the program. After that, you can convert files without the watermark.

Removing trial restrictions

My file does not open
• Check the list of supported formats to see if this file format is supported by the converter.
• If the format and codec are supported, the file may be damaged.
• Some DVDs and files can be protected with DRM against copying. The converter is not intended to make illegal copies of such files.

Supported formats

How do I update the graphics card driver?
You can download the latest graphics card driver from its manufacturer’s website. Only download drivers from the official manufacturer’s website. Third-party websites offering driver downloads may contain malware.
NVIDIA download center | AMD download center | Intel download center

Detailed instructions on updating drivers

System requirements

<table>
<thead>
<tr>
<th>System requirements</th>
<th>Minimum system requirements</th>
<th>Recommended configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP/Vista/7/8/10 with latest service packs and patches</td>
<td></td>
</tr>
<tr>
<td>Processor</td>
<td>Dual-core Intel, AMD or compatible processor, 1 GHz</td>
<td>Quad-core processor, 2.8 GHz or higher</td>
</tr>
<tr>
<td>Graphics</td>
<td>NVIDIA® GeForce™ series 6 or higher</td>
<td>OpenGL 2.1 and above is recommended for smooth performance</td>
</tr>
<tr>
<td></td>
<td>AMD Radeon™ R600 or higher graphics card with up-to-date drivers</td>
<td></td>
</tr>
<tr>
<td>Resolution</td>
<td>1024x768, 32-bit color</td>
<td>1280x1024 or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Windows XP, Vista – 512 MB</td>
<td>Windows XP – 2 GB</td>
</tr>
<tr>
<td></td>
<td>Windows 7/8/10 – 2 GB</td>
<td>Windows Vista/7/8/10 – 4 GB</td>
</tr>
<tr>
<td>Available disk space</td>
<td>110 MB for installation</td>
<td>2 GB</td>
</tr>
<tr>
<td></td>
<td>500 MB for ongoing operations</td>
<td>Video conversion may require several GB of additional space.</td>
</tr>
</tbody>
</table>
Additional features

- Sound card for audio playback
- Latest version of QuickTime Player for Windows for MOV processing
- Intel® hardware acceleration requires a compatible Intel processor supporting Intel HD Graphics™ 2nd generation or higher
- NVIDIA® hardware acceleration requires a compatible NVIDIA® CUDA™-enabled graphics card

Administrator permissions are required for installation

Movavi Video Converter Premium may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not met.

## Supported formats

<table>
<thead>
<tr>
<th>Video Formats</th>
<th>Supported Codecs</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>3GP, 3G2</td>
<td>H.263, H.264, MPEG-4</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>ASF</td>
<td>MPEG-4, VC-1, WMV V7</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>AVCHD</td>
<td>H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>AVI</td>
<td>H.264, MPEG-4, MJPEG</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>DivX, Xvid, DV, Cinepack, Fraps, TechSmith, Uncompressed</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DivX</td>
<td>DivX</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DVD</td>
<td>MPEG-1, MPEG-2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>FLV</td>
<td>FLV1, H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>H.263, VP6, Flash Screen Video</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>M2TS</td>
<td>MPEG-2, H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>M2TS, TS, MTS, M2T</td>
<td>MPEG-2, H.264, H.265</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>M4V</td>
<td>H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MKV</td>
<td>H.264, MPEG-4, MJPEG, Theora, VP9</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>H.265, DV, Uncompressed</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MOV</td>
<td>H.264, MPEG-4, MJPEG</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MOV, QT</td>
<td>H.264, MPEG-4, MJPEG, AIC, ProRes, Sorenson 1/3, PNG</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MP4</td>
<td>MPEG-4, H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MP4, M4V</td>
<td>MPEG-4, H.264, H.265, MJPEG, ProRes</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MPG, VOB</td>
<td>MPEG-1, MPEG-2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MPG, MPEG, MPE, M1V, VOB, DAT, MOD, TOD, VRO</td>
<td>MPEG-1, MPEG-2, H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MXF</td>
<td>MPEG-2, DV</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>OGV</td>
<td>Theora</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>MPEG-4</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>RM, RMVB</td>
<td>Real Video 2/3/4, Cooker</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SWF</td>
<td>FLV1</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>MJPEG</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>WebM</td>
<td>VP8, VP9</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>VP7</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>WMV</td>
<td>WMV V8</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>WMV V7, WMV 9, WMV 9 Screen, WMV 9 Advanced profile, MPEG-4, WMV 9.1 Image V2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>WTV</td>
<td>H.264, MPEG-2</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Audio Formats</th>
<th>Supported Codecs</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAC</td>
<td>AAC</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>AC3**</td>
<td>AC3</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>AIF, AIFF</td>
<td>Uncompressed</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>APE</td>
<td>Monkey's Audio</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>AU, SND</td>
<td>PCM</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>F4A</td>
<td>AAC, ALAC</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>FLAC</td>
<td>FLAC</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>M4A, M4B</td>
<td>AAC, ALAC, PCM</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>M4A</td>
<td>AAC, ALAC</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>M4R</td>
<td>AAC, ALAC</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

*** Format supported under Windows 8 and later.***
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card manufacturer’s website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of applications and games on your computer.

1: Find your graphics card manufacturer
1. Right-click your desktop and choose **Screen Resolution**
2. In the **Screen Resolution** settings window, click **Advanced settings**.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the **Adapter Type** section. Note the full name of the graphics card somewhere for later.

2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer’s website and find driver downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find the necessary driver.

- NVIDIA download center
- AMD download center
- Intel download center

3: Install driver
Once the file is completely downloaded, run the installation file and follow the on-screen instructions to install the driver on your system. Your display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

---

**Updating NVIDIA® Driver**
Modern NVIDIA graphics cards come with a special application called **NVIDIA GeForce™ Experience** that monitors driver updates and allows you to optimize your computer’s graphics performance.

1. Open the **NVIDIA GeForce Experience** application. It should already be installed on your system. If you cannot find the application, please try the method above.

2. In the **Drivers** section, click the **Check for updates** button to find the latest drivers.

3. When the application has found a newer driver, click the **Download driver** button. From here, the software will automatically download and install the necessary driver for your system.
Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website. AMD Driver Download Center

2. Download the auto detect utility and run it when the download has finished. Auto Detect Utility

3. The utility will then automatically find your graphics card and help you download and install the right driver for your system. If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and download the driver.

4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.

5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat. If possible, please include the name of your graphics card model (see 1), as well as screenshots of any error messages you have encountered. This will help our support team specialists solve your problem quicker.

OpenGL Troubleshooting

If you see the following message about OpenGL when you open Movavi Video Converter Premium or you've noticed that the player, filters, or transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Video Converter Premium, your computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver installation file from the manufacturer’s website and install it following the on-screen instructions. Detailed instructions on updating the driver

It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Video Converter Premium. If you see an error message again, proceed to the next step.

2: Try the software OpenGL implementation
If your graphics card still doesn’t support OpenGL 2.1 even after updating the driver, you can use a software alternative:

• In the message you see after starting the program, select the Download and install software OpenGL implementation box.
Or, in the main window, open the **Settings** menu and choose **Preferences**. There, select the **Use software OpenGL implementation** option and click OK.

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi Video Converter Premium.

If these steps haven't helped:

- Check that your computer meets the **minimum system requirements**. Your graphics card must support at least OpenGL 2.0.
- Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

**Codec activation**

Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply with patent law.

1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.

2. Select the **Activate other codecs without asking** box to activate all codecs automatically in the future. The codecs will be activated automatically, but an Internet connection is still necessary.

3. Click **Activate** to complete the codec activation.

**Codec could not be activated**

If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated even if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.

**What kind of data is being sent?**

The data we send does not contain any information that can personally identify you. We only receive information about which codecs were used.

**Glossary**

**General**

**Container Format (Video Format)**

A container format is a file format for storing video or audio files that contains video and audio data in separate streams, as well as any other associated data, such as subtitle tracks and additional data about the file. You can think of a container format as a box that holds together all the parts that make up a video file, as illustrated below. The container format is what you usually see when you work with video files: you can judge which format your video is in by the file extension: *.mp4 corresponds to MP4 format, *.mkv to Matroska format, etc.
**Codec**
While a video file contains video and audio streams, these streams are in turn *encoded* using a video or audio codec that compresses the data. You can think of a codec as a language: to play a video encoded with a certain codec, your player needs to be able to 'understand' how it was encoded, so that it can *decode* or decipher the file. If your computer does not know how to decode a new codec, you can fix this by converting the file to a different format or by installing a codec pack. However, please keep in mind that a lot of malware programs disguise themselves as codec packs; you should only download codec packs directly from codec manufacturers or from trusted sources.

**Bitrate**
When referring to media, bitrate is the number of bits that is played back each second. The higher the bitrate, the more details that can be conveyed with each second of the video or audio stream, and therefore, the higher the quality. There are two types of bitrate: constant bitrate (CBR) and variable bitrate (VBR). Videos with constant bitrate (CBR), as you can probably guess from the name, have the same bitrate for each and every frame of the video, no matter the complexity of the frame: simple frames, for example, those completely filled with black, have the same number of bits as complex, colorful frames. This has a number of limitations, since the simple frames take up more bits than needed to convey them, while complex frames are limited in quality. With variable bitrate, however, each frame is allotted only as many bits as it needs, without limiting quality or wasting data. In most cases, we recommend that you use variable bitrate, however, CBR is sometimes useful for streaming media.

**Frame Rate**
The frame rate, or frames per second (FPS) is the number of video frames that is contained in a second of video. At low frame rates, you may notice that the video is 'jittery', while higher frame rates produce a smooth high-quality video. Shooting videos at high frame rates (48 or 60 FPS) requires more resources and disc space, but you can easily slow down a high-FPS video to produce a slow-motion effect without producing visual stutter. The industry standard for cinema frame rate is 24 or 25 frames per second, which is perceived as comfortable to the human eye.

**Resolution**
Resolution is the number of pixels that can fit inside the video frame. It is usually presented as "width x height" of the frame, for example, 1280x720 or 1920x1080. Sometimes, resolutions may also be referred to as "720p" or "1080p", by the number of pixels in a frame vertically. At high resolutions, each frame is conveyed using more pixels, therefore allowing for more detail and higher quality, though taking up more disc space. Whenever you convert a video to a lower resolution, you irretrievably lose some data, but if you convert a low-resolution video to HD, the quality will stay the same. If you need to do so, however, we recommend that you use Upscale SD, DVD to HD presets in Movavi Video Converter, as they use an algorithm that slightly improves video quality when converting to larger resolutions.

**Sample Rate**
Sample rate, measured in Hertz, determines how many samples of digital audio are recorded each second. Higher sample rates allow you to record higher quality audio, although the files will take up slightly more space. The recommended sample rate is 44100 Hz, which is the standard for audio CDs, delivering sound that covers the full range of human hearing. To reduce file size, you can convert audio with lower sample rates, as low as 22 kHz, but keep in mind the quality deterioration.

**Video Formats**

**Audio Video Interleaved – AVI (*.avi)**
AVI is a multimedia container format created by Microsoft in the early 1990s. AVI supports multiple video and audio codecs and can contain up to 16 audio and 16 subtitle tracks. While support for AVI is widespread on all operating systems, it is steadily being replaced by more efficient formats.

**DivX (*.divx)**
DivX is a proprietary video format developed by DivX, Inc. Using its own codec, DivX allows for high compression rates while retaining high quality. Sometimes the DivX codec is also used to encode video in AVI files. DivX is not supported by many media players, and requires a codec pack to play, but you can convert DivX files into AVI or other formats using Movavi Video Converter.

**QuickTime – MOV (*.mov)**
Developed by Apple, QuickTime is natively supported on Macs and iOS devices, so if you need to be sure that your video can be played on a Mac, converting it to MOV would be a good idea. To play MOV files on Windows, you can either download and install the QuickTime player from Apple's official website, or view it using Movavi 3D Media Player.

**Other**
Interlaced Video, Deinterlacing Video
Video interlacing is a method used in traditional analogue video broadcasting that arose due to the limitations of early television. Each frame of the video is split into half-frames, each frame containing even and odd rows consecutively. This allows to broadcast at double the frame rate, producing a seemingly smoother video stream, while the eye does not notice the missing rows. However, on digital displays, interlaced video may produce visible defects in the form of horizontal lines. Deinterlacing helps remove these defects using algorithms by merging the two half-frames into one. Movavi Video Converter automatically deinterlaces output videos, and you can use the Deinterlace effect if you are editing analogue video in Movavi Video Editor.

Preset
A preset is a pre-made configuration that contains all the necessary properties to convert a video file, including format, codec, resolution, etc.

How to collect logs
Providing your log files when you contact support can help us solve your problem faster. The logs contain the program's actions for some period of time, as well as important error reports and descriptions. The log files do not contain any personal information.

1: Show hidden folders
1. Open the Control Panel and switch to Small icons view.
2. Click Folder Options.
3. Switch to the View tab.
4. Under Hidden files and folders, choose Show hidden files, folders, and drives.
5. Click OK.

Detailed instructions

2: Open the Logs folder
1. Go to your system drive (usually Local Disk C).
2. Open the Users folder.
3. Open the folder with your username.
4. There, open the AppData hidden folder.
5. From there, go to Local > Movavi > Logs.

Advanced: you can also simply enter the following into Windows Explorer's path bar at the top: "C:\Users\USERNAME\AppData\Local \Movavi\Logs", where USERNAME should be your user folder.

3: Send us the logs
1. Find the folder named VideoConverter19.
2. Archive this folder and attach this archive to your e-mail, support chat or contact form when you describe your problem.

How to take a screenshot
If you contact support about a problem, attaching a screenshot will allow us to solve your problem faster. Follow the steps below to take a screenshot with the standard tools:

1: Press the Prt Scr key on your keyboard. It's located on the top row right after the F keys.
To take a screenshot of just the active window, press Alt+Prt Scr

2: Open Paint or any other image editing program and press Ctrl+V to paste the screenshot. Then, trim the screenshot if you only want to show a part of the screen.

3: Save the screenshot to a folder where you can easily find it.

4: Attach this screenshot to the e-mail, chat, or support form when you describe your problem to our support team.

How to find system information
How to find your operating system version
1. Right-click your Computer icon.
2. Choose Properties from the pop-up menu.
3. In the System window, note the Windows edition and System type:

View basic information about your computer

Windows 7 Professional
Copyright © 2009 Microsoft Corporation. All rights reserved.
Service Pack 1
Get more features with a new edition of Windows 7

System:
Rating: Windows Experience Index
Processor: Intel (R) Core(TM) i5-2300 CPU @ 2.80 GHz
Installed memory (RAM): 8.00 GB
System type: 64-bit Operating System
Pen and Touch: No Pen or Touch Input is available for this Display

How to find your graphics card information
1. Right-click on your desktop and choose **Display settings**
2. In the **Display settings** window that appears, click **Advanced display settings**. There you can find your GPU.